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Installation

In order to use SUGARfx with Final Cut Studio or Final Cut Express, you need to 
download and install the Free FxFactory plug-in from Noise Industries.

	 FxFactory is the host plug-in that makes SUGARfx available to the applications, so you need to 
first download FxFactory from the Noise Industries web site.

• FxFactory is a free download and the web site address is:

http://noiseindustries.com/products/fxfactory/download/index.html

• Install and follow the prompts during installation.

Installing SUGARfx

You should have received the code and information via e-mail, and downloaded the SUGARfx pack on 
your computer.

If you successfully installed FxFactory, then the icon of the SUGARfx should look just like a square brown 
box shown here.

• Double click and it should automatically be moved to its correct place and ready to be used with your 
applications.

For more information on FxFactory, please read the instructions and/or the help file that came with it, or 
visit their support page on their web site (www.noiseindustries.com).

http://noiseindustries.com/products/fxfactory/download/index.html
http://noiseindustries.com
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The Design Tools

Meet the Design Tools from SUGARfx

The Design Tools pack is a collection of filters and generators that offer the basic design, layout and 
format tools missing from the host applications. The Design Tools gives you the ability to create your 
own layouts, check your work against several presentation formats, keep the continuity in your designs, 
reuse color palettes, etc.

The Design Tools include several elements:

•	 Checker Guides : A set of useful checker guides for the usual presentation formats like film, HD, 
mobile devices and digital signage.

•	 Color Palette : Allows you to set and save your favorite color palettes for special jobs, color 
combinations that work, client palettes, branding colors and so on.

•	 Custom Guides : This generator gives you the ability to create your own guides exactly where 
you want them and how you want them so you can position the elements in the right place all 
the time.

•	 Digital Signage : This is a filter to make your digital signage editing much easier than just having 
an additional monitor, by turning your asset in the right direction.

•	 Proportional Guides : This will give you the guides that adjust proportionally to your editing 
format.

Bonus:

•	 Player Preview : This is a bonus filter that lets you check your edited piece as it could be seen in 
some of the most popular mobile players.
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Using Design Tools

Open Final Cut Pro or Final Cut Express and browse to the Effects Tab.

The screen shots shown on this manual are from Final Cut Pro but there should be no difference in the 
functionality of the SUGARfx plug-in even if you use Final Cut Express.

Open Final Cut Pro / Express

The Design Tools contains several Generators and Filters and a bonus preview player.

You will be able to find the SUGARfx Design Tools elements under the Video Generator Effects and in the 
Filters menu. 

 

If you want to use one of the Filters, you need to have a video asset in your time line before you try to 
access the filters menu.

As you may already know, the filters can be accessed in two different ways.

One is by going into the Effects tab in the Browser window where you will find the Video Filters folder, 
and inside there you should find another folder containing the SUGARfx Toolbox filters with their 
corresponding names (Digital Signage and Player Preview).

If you use this method to apply your filters, then select the filter of your choice and drag it and place it 
on top of the video asset in your time line until you see the video asset gets highlighted. Then, let the 
mouse go so the filter gets applied onto your video footage. 

Another method to access the filters is as follows: you need to first select the video asset you want to 
affect and then go to the menu Effects > Video Filters > SUGARfx Toolbox > and select the filter of 
your choice.

After applying the filter using either method, you now have to double-click the affected video in the 
time line in order to see its control parameters in the Viewer window.
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•	 Go to the Viewer window and click on the Controls tab to access its parameters.

•	 There you can adjust the parameters to your liking, save presets or load your favorite ones.

Not every filter included in the SUGARfx Toolbox has its own set of parameters and 
their settings vary from one to the other.

In the following sections you will be able to learn about the parameters of each individual filter.
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SUGARfx Checker Guides is a generator that provide a way to check your edited work 
against multiple standard video guides such as 35mm film, High Definition, mobile 
devices and others. 
 

 
 
A perfect example of its use is when you need to check the center cut of an High 
Definition clip when it is presented in Standard Definition (as seen above).

In order to use it, you will have to place the Checker Guides generator on a second layer right on top of 
your edited video, double-click it and go to the Viewer window to access the parameters by selecting 
the Controls Tab. 

Checker Guides
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Parameters

•	 User Manual : One of the most important things you need to know about all of our products is 
that when you select the SUGAR logo or the USER MANUAL button on the interface, you will gain 
access to the on-line manual that you can either download or read on-line. 

	

Main Setup

This section allows you to set the main parameters where you can select what guides to display and 
adjust them if necessary.

 

 

•	 Checker Guides : This is the heart of this filter. Here you will select what guides you want to 
check your work against, and you have several options to choose from.

	 You will be able to check your work against the following formats:

	 4x3 (standard definition in NTSC and/or PAL)

	 4x3 NTSC (Flexible) : meaning that the guides stretch to fit in your edited video, so you can see 
where the guides fall if you decide to include the whole image (squeezed or stretched) in the 4x3 
format.

	 35 mm : You will be able to see how your work may be presented in various 35 mm formats.

	 HD : A basic HD guide.

	 Digital Signage : If you need to show your work in this popular format.
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	 Mobile formats (iPhone and iPod) : To make sure that your work finds the perfect home, and plays 
nice in the most popular mobile devices. 

•	 Manual Adjustment : The default guides are setup to show you how your work may be displayed 
in several formats, and with this adjustment parameter you have the flexibility to resize those 
guides and see what you need to do to cover all or parts of your work for the format you are 
aiming for. – We suggest that you leave this parameter alone, unless you want to experiment with 
other viewable options.

•	 Opacity : Controls the opacity of the checker guides.

Guide Selector

This section allows you to enable/disable the guides shown on the screen.

•	 Title Safe : Shows the guides that correspond to the best possible limit of your text location on 
screen in order to be elegantly viewed by your audience.

•	 Action Safe : Shows the guides that correspond to the maximum safe limit of the viewable action 
of the video on screen.

•	 Center : Shows the center guides.

•	 Full Frame : Shows the full frame of the format selected.

Colors

This section allows you to color the different guides to easily identify them, and each of the colors 
correspond to the guides explained in the previous section.
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SUGARfx Color Palette is an easy to use, useful way to save your own palettes to match 
your client’s branding, special color combinations or simply save your favorite colors.

The Color Palette is also a generator that can be used on a top layer to match your video colors or as 
reference for usual projects that require color branding. 

 

A perfect example for this filter is to save a preset and share it with all the editors in the chain as a color 
palette that is required on a critical job that keeps the color branding of your client consistent.

Parameters

•	 User Manual : One of the most important things you need to know about all of our products is 
that when you select the SUGAR logo or the USER MANUAL button on the interface, you will gain 
access to the on-line manual that you can either download or read on-line. 

	  

•	 Presets : If you would like to use a Preset, you can do that with the pull down menu, you can also 
create your own presets and save them or share them with your peers.

Here is where you can save your own Presets after customizing the look and setups you use the most.

Color Palette
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Main Setup

This section allows you to give a name to your Color Palette as well as enable a handy color mixer. 

	

•	 Custom Label : Type in the name or label you want for the color palette.

•	 Enable Mixer : This button enables a basic color mixer that appears in the top side of the screen, 
where you can set 2 colors and mix them together.

Color Mixer

This section is available only if you selected Enable Mixer in the Main Setup. One reason why you 
want to use this Color Mixer is if you feel the need to have a new color combination that comes from a 
mixture of some of your colors. 
 

 

 
When enabled, you will see an additional color mixer palette on the top part of the screen.
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Here you can select any two colors and mix them to create a new color that you can use and set it into 
the color palette at the bottom.

Keep in mind that the Color Mixer colors are not saved in the Presets, and it is used only to obtain a color 
that otherwise would not be in your palette. 

•	 First : This color well allows you to select the first color that you want to mix.

•	 Second : This color well allows you to select the second color that you want to mix.

•	 Mixing Point : A slider to adjust how much of the First and the second color is added to the mix.

Color Wells

The color wells are obviously here to set the different colors of your new palette. 
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SUGARfx Custom Guides is a plug-in that 
provides the editor with a set of on-screen 
guides to help in the layout, positioning or any 
other use that requires an exact placement of 
elements or orientation and guides that can be 
positioned anywhere on the screen. 

Filter Parameters

•	 User Manual : One of the most important things 
you need to know about all of our products is 
that when you select the SUGAR logo or the USER 
MANUAL button on the interface, you will gain 
access to the on-line manual that you can either 
download or read on-line. 

	  

•	 Presets : If you would like to use a Preset, you can 

Custom Guides
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do that with the pull down menu, you can also create your own presets and save them or share 
them with your peers.

Main Setup

This section allows you to enable the Label, set the Line Weight and Opacity of the guides on-screen.

•	 Label : This button enables the label that you can use to name your setup. 
 

 

•	 Line Weight : Sets the weight of the guide-lines.

•	 Opacity : Controls the opacity of your guides.

Horizontal

This section refers to the Horizontal guides that you can position in the Canvas window. 

 

•	 Number of Guides : Select the number of guides you want to use.

•	 Color : Change the color of the Horizontal guides - The default is green.
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•	 Number ID : This button is enabled so you can recognize where is the number of the guide that 
you need to adjust or move. Click to disable it so the numbers no longer appear on-screen.

•	 1-10 Horizontal : Every guide can be positioned individually from each other. Just make sure the 
Number of Guides correspond to the guides you are positioning so you can see them on-screen.

Vertical

This section refers to the Vertical guides that you can position in the Canvas window. 

 

•	 Number of Guides : Select the number of guides you want to use.

•	 Color : Change the color of the Vertical guides - The default is red.

•	 Number ID : This button is enabled so you can recognize where is the number of the guide that 
you need to adjust or move. Click to disable it so the numbers no longer appear on-screen.

•	 1-10 Horizontal : Every guide can be positioned individually from each other. Just make sure the 
Number of Guides correspond to the guides you are positioning so you can see them on-screen.

Label

This section appears only when it is enabled in the Main Setup, and here is where you can enter a name 
to your custom guides setup so it shows on-screen. 
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•	 Label : Enter the name or description that you want in here.

•	 Position : Click the cross-hair to position the label on the Canvas window, or enter the number in 
the spaces provided.

•	 Size : Sets the size of your label.

•	 Opacity : Changes the opacity of the label.
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SUGARfx Digital Signage is a Filter plug-in that takes your horizontal video footage and 
rotates it 90° so it is easy to edit without external monitoring.

Digital Signage advertising is considered to be an emerging market and it is increasing by the minute. 
The displays are used in Shopping Centers, Museums, Markets and many other locations delivering 
targeted messages, video and animation to targeted audiences.

The video footage used for this marketing technology can be shot in any way as well as sideways to take 
advantage of the full resolution of a video clip that will fit perfectly in this medium.

 

Filter Parameters

•	 User Manual : One of the most important things you need to know about all of our products is 
that when you select the SUGAR logo or the USER MANUAL button on the interface, you will gain 
access to the on-line manual that you can either download or read on-line. 

Digital Signage
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This filter does not use Presets because there is no need for that.

Main Setup

This section allows you to set the main parameters that control the main features of your plug-in. 

 

•	 Flip : It literally flips the video if it was shot in the opposite sideways direction. Since this is an on 
and off button, you will see that your video footage may or may not need to be flipped. 

	  

•	 Opacity : Controls the visibility or opacity of the Safe Title, Safe Action and Full Frame guides.
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Colors

These color parameters allow you to color the guides as you please.

Mix

Every single filter in Final Cut Pro has this setting included by default and can be used as an opacity.
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SUGARfx Proportional Guides is a generator plug-in that, as its name implies, provides 
guides that divide the screen proportionally in a vertical or horizontal position.

If you are familiar with the framing of elements used in video shoots also known as the “rule of 
thirds”, then the proportional guides plug-in will give you a visual aid to divide your working area in 
symmetrical (proportional) spaces across the canvas so you can position layout elements exactly where 
you know they’ll look their best. 

 
The Proportional Guides also give you the ability to add more guides in either direction, dividing your 
canvas in equal spaces for the purpose of your own design or otherwise.

Parameters

•	 User Manual : One of the most important things you need to know about all of our products is 
that when you select the SUGAR logo or the USER MANUAL button on the interface, you will gain 
access to the on-line manual that you can either download or read on-line. 

	  

•	 Presets : Create your own presets and save them or share them with your peers.

Proportional Guides
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Main Setup

This section provides the Main and only parameters that control the Vertical and Horizontal division of 
your guides. 

 

•	 Vertical : A slider that allows you to dial how many proportional guides you want in the vertical 
direction.

•	 Horizontal : A slider that allows you to dial how many proportional guides you want in the 
horizontal direction.

 •	Line Weight : Sets the width or thickness of your guides.

 •	Color : Set the color of your guides.

 •	Opacity : Controls the opacity of your guides.
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SUGARfx Player Preview is a bonus Filter plug-in that provides a fast and easy way 
to check your work as if it was being displayed in some of the most popular mobile 
devices.

After applying the filter to your video asset, double-click the video and go to the Viewer window in 
order to access the parameters by selecting the Filters Tab. 

		

Filter Parameters

•	 User Manual : One of the most important things you need to know about all of our products is 
that when you select the SUGAR logo or the USER MANUAL button on the interface, you will gain 
access to the on-line manual that you can either download or read on-line. 

	

Main Setup

This section provides the simple parameters to select the player and a basic adjustment. 

 

Player Preview
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•	 Select Player : This is a drop down menu where you can select the player that you want to 
preview. 

	  

 

•	 Adjust Fitting : By using this slider you will be able to adjust the video inside the player. The 
middle point of 0.5 is the default and should be the closest preview to what you will get in the 
real world.
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Presets

The presets expand your plug-ins even further, specially when you can create your 
own styles and setups and save them for later use.

Some of the SUGARfx Design Tools filters already include several presets that you can use. 

 

In some cases it is a good idea to begin your own customizing by selecting one of the included presets 
and use it as a starting point to create your own.  

Have fun and start making your own, and remember that you can share the presets with other users or 
other computers as long as they have the same versions installed in their system.
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Support

Every SUGARfx theme or plug-in that you purchase comes with free technical support 
by sending all your questions via e-mail to our Support Team.

Our Technical support team is available to answer your questions via e-mail and should respond within 
24 hours or less from the time the e-mail was received.

Things to know before contacting Technical Support

Please visit our web site (http://www.sugarfx.tv) for possible answers to your technical support issues, 
or visit our tutorial site (http://www.ilearnfast.com) where you may also find a tutorial that will help you 
find the answer to your question before you contact our Support team.

If you cannot find the answer you need, please send us an e-mail to :  support@sugarfx.tv with the 
following information:

•	 Name and version of the SUGARfx theme.

•	 The version of the FxFactory.

•	 Your system configuration (Mac OS X version, RAM and whatever else you may think to be 
helpful)

•	 The application name and version with which you are having the problem.

•	 Screen shots of the problem (whenever possible).

•	 Details and any other information you may think appropriate to describe the problem.

Feedback

The success of our products depend vastly on customer requests and feedback.

We welcome all kinds of e-mails that provide useful information on how to improve our products, so we 
encourage you, as a user of these products, to send us your feedback or comments to our support team.

Design Tools Manual v1.0 / May 2008

http://www.ilearnfast.com
mailto:support@sugarfx.tv

	Installation
	The Design Tools
	Using Design Tools
	Checker Guides
	Color Palette
	Custom Guides
	Digital Signage
	Proportional Guides
	Player Preview
	Presets
	Support

